
Geometer’s Sketchpad:  
A tool for conceptual understanding and mathematical exploration.  

 
 
Geometer’s Sketchpad is a dynamic geometry software application that can be used to 
teach, reinforce, and explore many mathematical concepts in geometry and algebra.   
 
These first activities are designed to introduce you to some of the features Geometer’s 
Sketchpad (GSP) has to offer.  You might find it useful to take notes in the space 
provided or on a separate sheet of paper.  However, some of the best features of this 
version of GSP are the Help pages, which are available by choosing Contents from the 
Help menu at the top right of the page.  
 

1. Use the compass tool to construct a circle in the middle of the screen.   
 
 

2. Use the selection tool to grab the point on the circle and observe what happens as 
you move the point.  To grab an object, place the cursor over the object, then 
click and hold the (left) mouse button.  
 
  

3. Now, use the selection tool to grab and move the center of the circle.  How is 
what happens the same or different than what happened in 2? 
 
 

4. Use the selection tool to grab the circle.  Is this similar to grabbing the point on 
the circle or the center? 
 
 

5. Move the circle to the upper left corner of the screen. 
 

6. Use the straightedge tool to construct a segment in the middle of the screen.  To 
create a segment, select the straightedge tool – being sure it is set to segment, 
rather than line or ray (to change the selection, click and hold on the straightedge 
tool, move the cursor to the appropriate selection, then release the mouse button. 
Next, click on the screen to construct one endpoint, then click on another location 
on the screen to construct the other endpoint (and the segment).     
 

7. Choose the selection tool (you can always get back to the selection tool by hitting 
the esc key) and then click the mouse on an empty space on the page.  This makes 
sure that no item is selected. 
 

8. Place the cursor over the segment you create and click the mouse.  Note that the 
segment becomes “highlighted.”   
 

9. Click on one of the endpoints of the segment.  Note that the segment is still 
highlighted even after you highlighted the endpoint.  
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10. Click on the endpoint again and note that the point is no longer highlighted.   
 

11. Being sure that the segment is still highlighted, open the Construct menu by 
clicking on Construct at the top of the page.  Notice that the only two options that 
are available are “Point on Segment” and “Midpoint” (the others appear 
lighter).    
 

12. Choose Midpoint by moving the cursor down to “Midpoint” and clicking the 
mouse button.  Note that this can also be done by typing  - M (that is, typing 
“m” while holding down the Apple key, ) on a Macintosh and ctrl – m on a 
Windows machine.   
 

13. The midpoint of the segment should now be highlighted.  Use the selection tool to 
select the segment again and “deselect” the midpoint (by clicking on them).  You 
could also deselect all objects (click on an empty space on the sketch), then click 
on the segment.   
 

14. Choose the Measure menu at the top of the page and select Length (the only 
other options when a segment is highlighted are Slope and Calculate). Note that 
the length of the segment appears on the screen.   
 

15. You can use the Measure menu to measure other quantities as well.  Select the 
circle (and nothing else) and have GSP compute the area and circumference of the 
circle.  Are there any other measurements that can be made with the objects 
you’ve created? Try it! 
 
 
 

16. What happens to these measurements when you alter the objects? Try it!  
 
Remember, you can always choose Undo from the Edit menu if you move or 
delete something accidentally.  
 
 
 



Geometer’s Sketchpad Introduction 

3 

Triangles 
 

1. Create a new sketch by choosing New Sketch from the File menu. 
 

2. Use the segment tool to construct a triangle.  First construct a segment, then 
another segment with “starting point” at one of the endpoints of the original 
segment.  Note that when using the segment tool, a segment’s endpoint “grows” 
when the mouse cursor is directly over it, telling you that if you click, you will 
begin at that endpoint.   
 
 

3. Now, use the Label tool (pointing finger) to label the three vertices of the triangle 
you just constructed.  
 

4. Use the Selection tool to highlight the vertices in the following order: First A, 
then B, then C.  Be sure that nothing else is highlighted. If that’s not the case, 
click on an empty space (to “un-highlight” everything) then select the three 
vertices again.   
 

5. Choose Angle from the Measure menu.  What angle got measured? 
 
 

6. Have Sketchpad measure the other two angles of triangle ABC for you.  In what 
order should you select the vertices in order to measure angle BCA? Angle BAC?  
What about angle CAB?  In what way does order matter? 
 

7. Use the selection tool to grab one or more of the vertices or edges of the triangle.  
What happens to the angle measurements as the objects move? 
 
 

8. What is the sum of the three angle measurements you measured?  Is the sum what 
you expect it to be?  What happens to this sum when you move the vertices? 
 
 

9. Now, we’ll have Sketchpad compute the sum for us.  Choose Calculate from the 
Measure menu. Notice that a calculator “pops up”. 
 

10. Click on one of the angle measurements from your triangle, then either click on 
the “+” on the popup calculator or type +.  Note that the calculator window will 
display what you are entering. 
 

11. Click on another angle from your triangle, then +, then the third angle.  Click on 
the OK button on the calculator to compute the sum.  What do you get?  Is it what 
you expected?  Is it what you got when yon calculated “by hand”? 
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Other polygons 
 
1. Use GSP to construct a quadrilateral and compute the sum of the measurements of its 

angles.  Is the situation the same as it was with triangles?  Do you always get the 
same sum?  If so, what is the common sum? 
 
 
 

2. Repeat problem 1, this time with a pentagon.   
 
 
 
 

3. Repeat problems 1 and 2 with a hexagon.   
 
 
 
 

4. Make a conjecture about the angle sum of an octagon.  Use GSP to check your 
conjecture.  
 
 
 

5. What is the angle sum of a decagon (a 10-sided polygon)? 
 
  

6. Have you figured out a way to make the formula fail?  For 
what type of polygons does the formula fail to work?  Try to 
make one of the angles greater than 180 degrees as in the 
figure on the right.  What happens to the angle sum? What’s 
going on?  
  
 

As it turns out, in order for the formula to work with Sketchpad, the polygon must have 
the property that if you connect any two points on or inside the polygon (that is, on the 
interior or an edge) with a  segment, then the whole segment must lie on or inside the 
polygon.  Such a polygon is called convex.  Forget about GSP for a second.  Does the 
actual formula still work when the polygon isn’t convex? 

G

D

E

F
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Back to some GSP features 
 

1. Create a new sketch and construct a segment. 
 

2. Use the selection tool to grab and move the segment’s length so that it appears 
just above the segment on the page.   
 

3. Use the selection tool to make sure that the segment and both endpoints are the 
only highlighted objects.  This can also be done by holding down the mouse 
button on an empty part of the page near the objects and creating a box around 
the objects (all objects in the box will become highlighted).    
 

4. Select Perpendicular Lines from the Construct menu.  What happens? 
 
 

5. How can you construct the perpendicular bisector of the segment?  Try it! 
 
 
 

Now, I’d like to clean up the picture by removing some of the extraneous objects. 
 

6. Use the selection tool to select one of the endpoints of the segment, being sure 
that nothing else is highlighted.   
 

7. Choose Cut from the Edit menu (alternatively, type  - x on a Mac or ctrl – x in  
Windows).  What happened?   
 
 

8. Since a little too much got eliminated there, choose Undo from the Edit menu 
(you can also type  - z on a Mac or ctrl – z in Windows). 
 

9. Now, select an endpoint of the segment (and nothing else) and select Hide from 
the Edit menu.  What happened this time?  
 
 
 
 
 

10. Do you remember the “compass and straightedge” construction of the 
perpendicular bisector?  Let’s try it! 
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Constructions versus drawings 
 
1. Open a new sketch by selecting New Sketch from the File menu.   
2. Draw a rectangle using the straightedge tool (set to segment).   Note that points 

“expand” when the cursor is on top of them, allowing you to be sure that you’re 
“connecting the dots”. 
 
 

3. What happens if you grab and move one of the vertices?  Do you still have a 
rectangle? 
 

4. Using the text tool, click on the vertices one at a time.  What happens? 
 

5. Now, using the selection tool, select points A, B, and C, in that order, then choose 
“Angle” from the Measure menu.  What happens? 
 

6. Now, have GSP measure the other 4 angles.  What should the sum of the angles 
be?  Is the sum what you expect?  
 
 

7. Choose Calculate from the Measure menu.  A small calculator should appear on 
the screen.  

8. Be sure the calculator does not block your view of the quadrilateral by grabbing 
the top of its window and moving it, if necessary. 

9. Click on the measure of one of the 4 angles, then click on the “+” on the 
calculator, then click on the measure of another angle, then click “+”, and so on 
until you have added all 4 angles on the calculator.  Finally, click “OK”. 

10. Does the angle sum given by the calculator agree with the one you computed 
earlier?  
 

Now, we’ll construct a rectangle. 
 

11. Open a new sketch by selecting New Sketch from the File menu.   
12. Construct a segment and the lines perpendicular to the segment through the two 

endpoints of the segment.   
 
 

13. Use the point tool to construct a point on one of the two perpendicular lines.   
 
 

14. Construct the line through this new point that is parallel to the original segment.  
You’ll need to highlight the point and segment.   
 
 

15. Use the select tool to construct the fourth vertex of our rectangle by clicking on 
the intersection of the lines at which the point lies.   
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16. Hide the lines (but not the points or segment).   
 
 

17. Use the straightedge tool to construct the remaining three sides of the rectangle.   
 
 

18. Use the selection tool to grab and move various parts of the rectangle.  When does 
the rectangle move and when is it stretched or shrunk?  Try out various 
combinations.   
 

Special Points on a triangle: 
 

1. Open a new sketch by selecting New Sketch from the File menu.   
 

2. Construct a triangle using the straightedge tool.   
 
 

3. Construct the perpendicular bisector of two of the triangle’s edges, as well as the 
intersection of these two lines.   
 
 
 

4. Construct the perpendicular bisector of the third edge of the triangle.  What does 
the relationship seem to be between the three bisectors?   
 
 

5. Move the vertices of the triangle.  Does the relationship still seem to hold?  Can 
you prove that it always does? 
 
 
 
 
 
 

6. Construct the three angle bisectors of the triangle.  What relationship do they 
seem to have?  Can you prove it? 
 
 
 
 
 

7. Construct the three medians of the triangle (segment connecting vertices to the 
midpoint of the opposite side).  What relationship do they seem to have?  Can you 
prove it? 
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And now for something completely different 
 

1. Construct a circle on a new sketch 
 

2. Construct an inscribed angle on the circle by creating two chords sharing a 
common point. Label the three points A, B, and C with B as the vertex of the 
angle.  

                                           

B

A

C  
 

3. Using the selection tool, highlight A and C (in that order) and the circle, then 
choose “Arc on Circle” from the Construct menu.  
 
 

4. Open the Display menu, slide the cursor down to Color (to open its menu) and 
then select a different color from the color of the circle.  Which arc was 
constructed? 
 
 

5. Now, use the selection tool to deselect everything, then select C then A (in that 
order) and the circle and select “Arc on Circle” from the Construct menu.  Which 
arc is constructed this time? 
 
 

6. Change the color of this arc so that it differs from the color of the circle and the 
color of the first arc.   
 
 

7. Use the selection tool to highlight the minor arc (the smaller one) and choose 
“Arc Length” from the Measure menu. 
 

8. Measure angle ABC by highlighting A, B, and C (be sure that B is in the middle) 
and selecting “Angle” from the measure menu.   
 

9. How do the two measurements compare as you move any of A, B, and C? 
 
 
 

10. Does the relationship you found always hold?  Can you prove it? 
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11.  Construct a new circle on your sketch. 
 

12. Use the straightedge tool to construct a line containing two points on the circle 
and label these points A and B (to change a label, double-click on it using the text 
tool and type in the new label).  Note that when the cursor is over the circle, the 
message “… from point on circle …” appears at the bottom right of the screen. 
 
 

13. Construct another line containing two different points on the circle.  Label these 
points C and D.   
 
 

14. Construct the intersection of the two lines.  Label the intersection X. 
 
 

15. Use the selection tool to move the points around and observe which objects move.  
 

16. Measure the lengths AX, BX, CX, and DX, then compute the products AX⋅ BX and 
CX⋅ DX.    How do these products compare when the points are moved around?  
In particular, does it matter whether X is inside or outside the circle? 
 
 

17. Can you prove that the relationship you observed always holds? 



Some additional explorations 
 

Try some of the following ‘problems, using Geometer’s Sketchpad.   
 

1. We know that the set of points that are equidistant from two points in the plane is 
the perpendicular bisector of the segment whose endpoints are the two points.  
But what if we didn’t know that?  Here’s a possible way to discover that fact.   
 
Plot two points in the middle of the screen and construct a segment at the top left 
portion of the screen.   
 
Construct circles centered at the two points each having a radius congruent to the 
segment you constructed.  You can do this by highlighting the two points (points A 
and B below) and the segment (without the endpoints), then selecting “Circles by 
center and radius” from the Construct menu.  (Note that we could have also 
Measured the Length of the segment and highlighted the length calculation 
instead of the segment itself) 
 

                

A B

 
Construct the intersection points of the two circles (if necessary, first grab the 
right endpoint of the segment and drag it to increase the length of the radii so that 
the circles intersect).  Notice that since the two circles have congruent radii, the 
intersection points will always be the same distance from A as they are from B. 
 
Highlight the intersection points of the circles and select “Trace Intersections” 
from the Display menu.    
 
Now, grab the right endpoint of the segment and slowly drag it back and forth (as 
far as you can make it go) to see all of the points that are equidistant from A and 
B.  If all went well, the points should trace out the perpendicular bisector of A 
and B.  To check this, construct the perpendicular bisector of A and B (by 
constructing

! 

AB, its midpoint, and the perpendicular line to 

! 

AB through the 
midpoint) and check! 

 
If you want to get rid of the trace, choose “Erase Trace” in the Display menu.  In order to 
stop having Sketchpad tracing the intersection points, highlight these two points (and 
nothing else) and select “Trace Points” from the Display menu again (this will “uncheck” 
Trace Points and it will be inactive until you ask it to trace another point (or points).   



The following problems are related to the one on the previous page.  Think about how 
you could adapt the previous method (or try another method).  As before, suppose A and 
B are two points in the plane.   
 

2. What do you think the set of points that are twice as far from A as they are from B 
will look like?  (A line, a segment, a ray, a parabola, a circle, an ellipse, …?) 
 
A quick way to be able to construct segments so that one is twice the length of the 
other is to create the larger segment and the subsegment from one of its endpoints 
to its midpoint.   

3. Would the set of points that are 3 times as close to A as they are to B have the 
shape as the figure in problem 2? 

4. What if the points are n times the distance from A as from B? 

 

5. Construct a circle, two points on the circle (neither should be on the of the parents 
of the circle), and the chord between the points.   
 
Next, construct the midpoint of the chord and, while the midpoint is still 
highlighted, choose “Trace Midpoint” from the Display menu.   
 
Now, keeping one of the endpoints of the chord stationary, grab the other 
endpoint and drag it about 1/4 of the way around the circle.  

     A

B

  

 
What do you think the resulting “locus” will look like?  Be 
as specific as possible.  Don’t just describe the general 
shape, describe some specific properties (For example, if 
you think you get a circle, specify its center and radius (or 
diameter)).  Continue dragging the point around the circle 
to test your conjecture

6. Repeat problem 5, but this time choose the point that is 1/4 of the way from the 
leftmost endpoint of the segment and the rightmost endpoint.  Guess the shape 
(and its specific features) and check your guess.   

7. Repeat problem 5 (and 6) but just place an arbitrary point on the chord.  Note that 
the ratio of the distance from the point to one of the endpoints of the chord and 
the length of the chord remain constant.   

Can you justify your conjecture more “rigorously” than observing that it seems to be 
right? 



Construct a line segment and label the endpoints of your original segment A and B  

Construct the perpendicular bisector of (using the Construct Midpoint and Construct 
Perpendicular commands) 

Now, construct a point on the perpendicular bisector of 

! 

AB  and label it C.   

A B

C

  

What do you notice about the distances AC and BC?  If you 
move stuff around, does this relationship remain?   

Why must this relationship always hold? 

Do you think the relationship is reciprocal?  That is, if a 
point D satisfies the relationship (for AD and BD), then 
does D have to be on the perpendicular bisector of 

! 

AB? 

Why must this relationship always hold? 

 

Construct a triangle using the segment tool.   

Construct the perpendicular bisectors of two of the sides of the triangle and label their 
intersection X.  Then, hide the two perpendicular bisectors by highlighting them (and 
only them) and choosing Hide Perpendicular Lines from the Display menu.   

 

Construct the perpendicular bisector of the third 
side of the triangle. What do you notice?  Move the 
vertices of the triangle and see if the relationship 
still seems to hold.   

Why must it always hold? 

 

Investigate:  When do the perpendicular bisectors meet inside the triangle?  Outside the 
triangle?  On the triangle?  Be as specific as you can be.   

Definition:  The intersection of the perpendicular bisectors of the sides of a triangle is 
called the circumcenter of the triangle.   

Construct the circle centered at the circumcenter of your triangle and going through one 
of the vertices of the triangle.  What do you notice? 



Last time, we confirmed that the perpendicular bisectors of the three sides of a triangle intersect 
at a single point, called the circumcenter of the triangle.  The circumcenter is the center of the 
circle (called the circumcircle of the triangle) that contains the three vertices of the triangle.   
 
Today, we’re going to investigate whether this common intersection property works for other 
lines connected to the triangle. 
 
Investigate the following questions with Geometer’s Sketchpad and work to confirm your 
conclusions.   
 
1. Do the angle bisectors of the triangle intersect at a single point?   
 
 
 
 
 
 
 
 
 
 
 
 
2. Do the medians (segment connecting a vertex to the midpoint of the opposite side)? 
 
 
 
 
 
 
 
 
 
 
 
 
3. Do the altitudes (through a vertex and perpendicular to the opposite side)? 
 
 
 



The circumcenter is the center of a triangle's circumcircle. It can be found as the intersection of 
the perpendicular bisectors. 
 
The geometric centroid (center of mass) of the polygon vertices of a triangle is the point which is 
the intersection of the triangle's three triangle medians (Johnson 1929, p. 249; Wells 1991, p. 
150). The point is therefore sometimes called the median point. The centroid is always in the 
interior of the triangle. 
 
The intersection of the three altitudes of a triangle is called the orthocenter. 
 
The incenter is the center of a triangle's incircle. It can be found as the intersection of angle 
bisectors, and it is the interior point for which distances to the sides of the triangle are equal. 
 
 
1. Use Geometer’s Sketchpad to construct a triangle and its circumcenter, centroid, orthocenter, 

and incenter (but hide all of the stuff that led you to these points). 
 
 
 
 
 

2. Move the vertices of your triangle, keeping an eye on the 4 special points.  What do you 
notice?   
 
 
 
 
 
 

3. Does any group of more than two points seem to be collinear? 
 
 
 
 

4. For what kinds of triangle will the circumcenter be the same as one or more of the other 
points? For what kind of triangle are all 4 points the same? 

 
 



The Euler Line of a triangle is the line on which the orthocenter, triangle centroid, circumcenter, 
nine-point center, and number of other important triangle centers lie. 
 
 
1. Does the incenter ever seem to lie on the Euler Line? 

 
 
 

2. Construct the midpoint of the segment with endpoints at the circumcenter and orthocenter.  
Label this point N.    
 

3. Construct the circle centered at N going through the midpoint of one of the sides.  Does it 
matter which midpoint you choose?  Hmm, isn’t that interesting? 
 
 
 

 
 
The nine-point circle, also called Euler's circle or the Feuerbach circle, is the circle that passes 
through the feet of the perpendiculars HA, HB, and HC dropped from the vertices of any triangle 
ABC on the sides opposite them. Euler showed in 1765 that it also passes through the midpoints 
MA, MB, and MC of the sides of ABC. By Feuerbach's theorem, the nine-point circle also passes 
through the midpoints EA, EB, and EC of the segments that join the vertices and the orthocenter H. 
These points are commonly referred to as the Euler points. These three triples of points make 
nine in all, giving the circle its name. Its center, N (the nine-point center), is the midpoint of the 
line between the circumcenter and orthocenter. 
 

 



Political Geometry: Putting the “spin” on “flip flops” 
 
In this activity, we’ll investigate transformations with Geometer’s Sketchpad.   
1. Construct a non-regular pentagon using the segment tool and use the point tool to 

construct a point that does not lie on the pentagon.  

                                               

D

C
B

A

E

 
2. Double-click on the point to mark it as the center of a rotation (alternatively, you can 

select the point then choose Mark center from the Transform menu).   
3. Now, highlight the pentagon and choose Rotate… from the Transform menu. When 

the dialog box opens, type “30” when prompted for an Angle.  What happened? 
 

4. You can also use the selection tool (rotate) to rotate the pentagon any angle if the 
pentagon is highlighted.  Try it! 

5. Move the point you marked as the center of rotation and observe what happens to the 
rotated pentagon.  Then, move the original pentagon and observe the effect. 

6. Now, highlight the pentagon and choose Translate… from the Transform menu.   
7. When the dialog box appears, choose “Polar” and type in an angle and distance.  

Observe what happens. What is Sketchpad doing? 
8. Repeat steps 6 and 7, but this time choose “Rectangular” and choose a Horizontal and 

Vertical distance to translate.  What is Sketchpad doing here? 
9. Next, create a segment on the screen and highlight the two endpoints then choose 

Mark vector from the Transform menu.   
10. Highlight the pentagon and choose Translate… from the Transform menu.  What 

happens? 
11. Select one of the endpoints of the segment that defined the translation and move it.  

What effect does this have on the translated pentagon? 
12. Select the pentagon and choose Copy from the Edit menu (or type ctrl-c).   
13. Open a new sketch by typing ctrl-n or choosing New Sketch from the File menu. 
14. Choose Paste from the Edit menu (or type ctrl-v).   
15. Construct a segment with the straightedge tool then choose the select tool and 

double-click on the segment to mark it as a mirror (or  highlight the segment, then 
choose Mark mirror from the Transform menu). 

16. Highlight the pentagon and choose Reflect… from the Transform menu. 
17. Move the mirror and/or move the original pentagon.  What’s the effect? 
 
Now, we’ll look at multiple transformations (one after the other) 



 
18. Construct two intersecting lines (with no specific orientation - we’ll move them 

around, eventually) and label them L and M.   
19. Construct a pentagon (again, without any specific properties so we can alter its 

appearance) and label the vertices A, B, C, D, and E.  We’re going to reflect pentagon 
ABCDE over line L, then reflect the resulting pentagon over line M.  In both cases, 
we’ll use the Reflect command in the Transform menu.  
 

                                  

M

L

D

C
B

A

E

 
 

20. In order to do this, we need to “mark” the mirror and highlight the object being 
reflected.  First, to mark line L as the mirror, either double-click on line L (if you’re 
successful, line L will appear to vibrate briefly) or highlight line L and choose mark 
mirror from the Transform menu.  After marking the mirror, highlight pentagon 
ABCDE and select Reflect.  You should now see the desired reflection.  Use the text 
tool to display the vertices, being sure that the reflected image of A is labeled A’,  etc.  
Move one or more of the vertices of ABCDE and notice that the reflection changes 
with any changes to the original figure or mirror.   

21. Now, repeat the above process, this time marking line M as the mirror and 
highlighting pentagon A’B’C’D’E’ before selection Reflect from the Transform 
menu.   

22. Show the labels of the new reflection and be sure that you’ve got pentagon 
A’’B’’C’’D’’E’’.  Now, hide (or ignore) pentagon A’B’C’D’E’.  How could we have 
transformed ABCDE to pentagon A’’B’’C’’D’’E’’ directly? (Hint: it’s a rotation, but 
where does the center of rotation lie and what’s the angle of rotation?) 

23. Grab one of the points defining one of the mirrors and move it, thus changing the 
angle at which the mirrors intersect.  What effect does this motion have on your 
conjectured angle of rotation?  Using the  label/text tool, make a conjecture by 
filling in blank in the following sentence:  When the angle between the mirrors 
increases, the apparent angle of rotation               .  It might help to display the 
values of the angle between the mirrors and apparent angle of rotation for reference. 



24. Check your conjectures by first double-clicking the point you think is the center of 
rotation (or highlighting the point and selecting mark center in the Transform 
menu).  Then highlight pentagon ABCDE and select Rotate in the Transform menu.  
A dialog box will appear in which you are asked what angle you’d like to rotate the 
pentagon around the center of rotation.  Type in your angle, keeping in mind that a 
positive angle will go “counterclockwise” and a negative angle will cause a clockwise 
rotation.   

25. Does the result of the rotation end up on top of pentagon A’’B’’C’’D’’E’’?  If so, 
move pentagon ABCDE and lines L and M to ensure that the your rotation really is 
the same as the double reflection.  If your conjecture seems to hold true, go on to #28.  
If your conjecture did not turn out to be true, guess again and repeat #26. 

26. Take a few minutes to add to your conjecture.  Carefully write out the result of 
your work.  That is, spell out your conjectures, being sure to specify the precise 
location of the center of rotation and the relationship between the angle of 
rotation and the angle between the mirrors, including some reasons that you feel 
your conjecture should be correct. 

27. Now, move line L by “grabbing” one of the points which define L.  (You should be 
changing the angle at which L and M intersect.  You’ll probably notice that the 
rotated image no longer matches with the result of the double reflection.  That’s 
because, as you noticed above, the angle of rotation depends on the orientation of the 
two mirrors, L and M.  So, we need to start over, right?  Well, not necessarily.  Select 
the Edit menu and see if you can select undo translate point.  If so, you’ll be able to 
undo the change you just.  It might also be a good idea to select undo construct 
rotated objects, too, so we’re not distracted by the rotated image of our pentagon.   

28. We’ll now use the Rotate command a little differently.  The command also allows us 
to rotate via a marked angle.  If you know what angle you want to rotate (∠AXA’’, 
perhaps? - where X is our center of rotation), you can highlight it (in the order A, X, 
A’’) and select mark angle ... from the Transform menu.  This all assumes that 
you’ve already marked the center of rotation.  The nice thing about this method is that 
if you change the mirrors (and therefore A’’), it also changes the angle of rotation, so 
if you measure this angle, you can keep track of the relationship between the angle of 
rotation and the angle between the mirrors.   

29. Now, write your new conjecture concerning the value of the angle of rotation (as 
a function of the angle between the mirrors).  Don’t change your original 
conjecture - add this conjecture to your original.   

30. Now start a new sketch.  The question I’d like to consider now is what if the mirrors 
don’t intersect?  When we chose lines L  and M above, we insisted that the lines 
intersected, but what happens if the lines are parallel?  In the time remaining, 
investigate the  result of a double reflection over two parallel lines.  What familiar 
isometry appears to result?  How does the distance between the two lines affect the 
resulting isometry?   

 
 
 



Additional questions to consider 
• Can we verify that our conjecture concerning the double reflections is correct?  

Actually, it’s not as hard as it might appear.  Think carefully about what property 
must be satisfied by the center of rotation (as it relates to the result of the rotation) 
and consider the angles involved and try to verify your conjecture. 

• Can we do our original double reflection “in reverse”?  That is, if I give you a 
rotation with a given center and angle of rotation, can you find two mirrors so that 
the result of the double reflection over the two mirrors is the same as the result of 
the rotation? 

• Does it matter in what order two isometries are “combined”?  That is,  
• if we reflect over line L, then reflect the image over line M, is this identical to the 

result of reflecting over line M, then line L?   
• if we combine a reflection with rotation, does the order matter? 
• What if you combine two rotations, two translations, or a translation and a 

reflection, or a translation and a rotation?   
• What’s the result of a triple reflection? 
• How can we use GSP to create “Escher-type” tesselations? 



 

More reflections 

We’ve already looked into the result of a double reflection (whether the mirrors 
intersect, or not).  Now, we’re going to investigate the result of triple reflections, 
double rotations, and double translations.  
1. Construct three lines (labeled L, M, and N) which can move independently.  Orient 

them so that all three lines intersect, but not at a single point.   
2. Construct a polygon, reflect it over line L, reflect the resulting polygon over line M, 

and reflect this polygon over line N.    
3. In order to see better what’s going on, Hide the “intermediate” polygons (keeping the 

original and final polygon).  Earlier, you may have conjectured that the result of 
this triple reflection is itself a reflection.  Does this seem to be the case?  If so, 
where does the mirror appear to be?  Can you find a relationship between the 
original mirror and the new one you just found?  If not, how can you tell?  Is the 
resulting isometry a rotation or translation?  Recall that in order to show that an 
isometry is a reflection, you need to find the mirror, for a rotation you need to 
specify the center and angle of rotation, and for a translation, you need to specify 
a vector.   

4. Now, move one of your lines so that the three lines appear to intersect at a single 
point.  How does the conjecture look now?  Answer the same questions as in #3. 

5. To double check your conjecture from #4, Open a New Sketch, this time 
constructing the three lines so that they intersect at a single point.  The best way to do 
this might be to construct 2 arbitrary intersecting lines, construct the point at the 
intersection of these two lines, and construct a new line “starting” at this intersection 
point.  Perform a triple construction and check whether your conjecture seems to 
be correct.   

6. Now, check to see what the result is when you perform a double rotation.  Be sure to 
consider a number of cases (the two rotations have different or same centers, different 
or same angles).  You’ll probably notice (depending on the particular centers and 
angles you chose) that the resulting isometry seems to be a rotation.  Find the center 
and angle of rotation and try to determine whether there’s a relationship 
between the two original centers and angles of rotation.  It will probably help to 
have GSP measure the various angles involved.   

7. I’ve heard a claim that the composition of two rotations is either a rotation, 
translation, or the identity transformation.  We can get the identity transformation if 
our second rotation is ρ-1, where  ρ is the first rotation, but how can we get a 
translation?  Think about this before going on to the next step. 

8. Choose one of the vertices of your polygon and mark it as the center of your rotation.  
Now, rotate the polygon around this chosen center using whatever angle you choose.  
Next, select another vertex of the polygon and rotate the resulting polygon around this 
new center, but with the opposite angle.  Check that the result of this double 
rotation is, in fact, a translation.  What is the relationship between the direction 
and length of the translation and the two rotations? 
 
 



 
9. Perform a similar investigation concerning the composition of a reflection and a 

rotation.  Is the result a recognizable isometry?  Explain your observations and 
conjectures. Consider both cases 

  µ o !  and 
  ! o µ  (µ and ρ are the reflection and 

rotation) and whether or not the center of rotation is on the mirror.   
10. Now, write up all of the observations and conjectures you made in items 1-9 

carefully and completely. 
Finally, answer the following questions: 
11. How can you tell whether a given isometry is a rotation?  How can you determine the 

location of the center and value of the angle of rotation?  Provide step-by-step 
instructions. 

12. How can you tell whether a given isometry is a reflection?  How can you determine 
the location of the mirror?  Provide step-by-step instructions. 

13. How can you tell whether a given isometry is a translation?  How can you determine 
the direction and length of the translation?  Provide step-by-step instructions. 



1 

Special tools 

1. Start up GSP and construct a triangle on the screen. 
2. Construct the perpendicular bisectors of two of the sides of the triangle.  Recall that 

the perpendicular bisectors of all three sides intersect at a single point.  Construct this 
point of intersection (it is known as the circumcenter of the triangle). 

3. Use the text tool (the “upper case A”) to show the label of the circumcenter you just 
constructed.   

4. Now, using the selection tool, double click on the label of the point.  You will be 
given the option to change the name of the chosen point.  Let’s call it what it is by 
typing circumcenter then click OK (note that there are other options we could 
have chosen - e.g. we could have changed the font or type size, too). 

5. What should be true about the distances from each vertex of your triangle to the 
circumcenter?  Check to see whether Sketchpad agrees with your conjecture  by 
measuring the distances from the triangle vertices to its circumcenter. 

6. Now, construct the circumcircle of your triangle.  It’s defined to be the unique circle 
which contains the vertices of your triangle (this also helps to answer why we call the 
intersection of the perpendicular bisectors of the triangle’s sides the circumcenter). 

7. Take a few minutes to discuss with your neighbors why the circumcircle is, in fact, 
unique.  That is, how do we know that there is exactly one circle which contains the 
vertices of your triangle?  

8. If your circumcircle construction was done correctly, you should now be able to move 
your triangle around and the circumcircle should “follow”.  Be sure that this is the 
case before moving on.   

9. Hide all of the extraneous stuff so that only the original triangle and the circumcenter 
are showing.  Remember, to Hide objects you need to highlight them (don’t forget 
that the Shift key allows you to highlight multiple objects) then choose Hide from the 
Edit menu (or type -h). 

10. Now, choose Select All from the Edit pulldown menu (or type -a).  All of your 
work should be highlighted. 

11. Press and hold the Custom tool icon and choose  Create New Tool from 
the Custom Tools menu that appears. 

12. Type “Circumcircle” to name this new tool and click OK. 
13. Press and hold on the Custom tool icon and select Circumcircle from the menu.   
14. On an open part of the sketch, click on three points.  What happens?   

Activity: 
Construct a triangle and its circumcenter.  Next, construct its orthocenter (the intersection 
of the altitudes of the triangle - the altitudes are the lines through the vertices which are 
perpendicular to the opposite side) of the triangle and the centroid (the intersection of the 
segments connecting vertices to the midpoint of the opposite side).  Label the 
orthocenter, centroid, and circumcenter and hide everything except these three points and 
the original triangle.  Move the triangle around and make a conjecture about the 
relationship between the three points.   



Graphing functions with Geometer’s Sketchpad 
 

In this activity, you’ll learn to sketch functions and see how to use sketchpad to explore 
the effect of changing the coefficients in the graphs of equations like 

! 

y = ax + b , 

! 

y = ax
2

+ bx + c , 

! 

y = ax
3

+ bx
2

+ cx + d , and 

! 

y = Asin(Bx +C )+D .   
 
1. Open a new sketch and choose “Show Grid” from the Graph menu.   

2. Choose “New Function” from the Graph menu and type in 3x-5 and click OK.  
(Notice that 

! 

f (x) = 3x " 5  appears on the screen.)  

3. Being sure that the function is highlighted, choose “Plot Function” from the Graph 
menu.  

4. There’s another way to plot graphs of functions with GSP.  Choose “Plot New 
Function” from the Graph menu and enter 3x+2 and click OK.  See what 
happened? 

5. Now, have GSP sketch the graphs of y = 3x + 1, y = 3x, y = 3x – 1, and y = 3x – 3.  
 
This is a fairly common strategy to get students to see that lines with the same slope are 
parallel and to understand the effect of the slope and y-intercept on the graph of the line.  
But we can make use of some of the features of GSP to do make this more of an 
exploration.   
 
6. Choose “New Parameter” from the Graph menu and name the parameter “a” by 

typing “a” and clicking OK.   

7. Repeat this process to create parameters named “b”, “c”, and “d”. 

8. Choose “Plot New Function” from the Graph menu.   

9. Click on the parameter “a” (on the sketch), then type  “*x +” and then click on the 
parameter “b” (the entry should look like a*x+b).  When you click OK, the 
function ax + b should now be highlighted on the screen and the graph of y = ax + b 
(for the stated parameters a and b, which are probably both equal to 1) will be 
sketched on the screen.   

10. Highlight the parameter a and hit the “+” key on number pad at the far right of the 
keyboard.  What happened?  What happens if you hit the “-“ key?  

11. Right-click on a parameter and choose “properties” from the menu that appears.  IN 
the “Parameter” submenu, change the “Keyboard (+/-) Adjustments” to 0.1 and 
observe what happens when you use the + and – keys.   

12. Experiment with functions of the type 

! 

y = ax
2

+ bx + c , 

! 

y = ax
3

+ bx
2

+ cx + d , and 

! 

y = Asin(Bx +C )+D , exploring the effect of changing parameters together or 
separately. 


